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IMPORTANT NOTICES
General
• This manual has been authored with simplified grammar, to meet the needs of international users.
• The operator of this equipment must read and follow the descriptions in this manual. Wrong operation or maintenance can cancel the warranty or cause injury.
• Do not copy any part of this manual without written permission from FURUNO.
• If this manual is lost or worn, contact your dealer about replacement.
• The contents of this manual and equipment specifications can change without notice.
• The example screens (or illustrations) shown in this manual can be different from the screens you
see on your display. The screens you see depend on your system configuration and equipment
settings.
• Save this manual for future reference.
• Any modification of the equipment (including software) by persons not authorized by FURUNO will
cancel the warranty.
• All brand and product names are trademarks, registered trademarks or service marks of their respective holders.
• Pentium is a trademark of Intel Corporation in the U.S. and/or other countries.
• Windows, Windows Vista, Internet Explorer, Microsoft Visual C++, and DirectX are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
• Ogg Vorbis is a registered trademark of the Xiph Organization.
• Java is a registered trademark of Oracle and/or its affiliates.

How to discard this product
Discard this product according to local regulations for the disposal of industrial waste. For disposal
in the USA, see the homepage of the Electronics Industries Alliance (http://www.eiae.org/) for the
correct method of disposal.

How to discard a used battery
Some FURUNO products have a battery(ies). To see if your product has a battery, see the chapter
on Maintenance. Follow the instructions below if a battery is used. Tape the + and - terminals of
battery before disposal to prevent fire, heat generation caused by short circuit.

In the European Union
The crossed-out trash can symbol indicates that all types of batteries
must not be discarded in standard trash, or at a trash site. Take the
used batteries to a battery collection site according to your national legislation and the Batteries Directive 2006/66/EU.

Cd

In the USA
The Mobius loop symbol (three chasing arrows) indicates that Ni-Cd
and lead-acid rechargeable batteries must be recycled. Take the used
batteries to a battery collection site according to local laws.

Ni-Cd

Pb

In other countries
There are no international standards for the battery recycle symbol. The number of symbols can
increase when the other countries make their own recycling symbols in the future.
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FOREWORD
A Word to the Owner of the Live Player V5 VR-7030
FURUNO Electric Company thanks you for purchasing the Live Player V5 VR-7030. We are confident you will discover why the FURUNO name has become synonymous with quality and reliability.
Since 1948, FURUNO Electric Company has enjoyed an enviable reputation for quality and reliability throughout the world. This dedication to excellence is furthered by our extensive global network of agents and dealers.
Please carefully read and follow the operation procedures set forth in this manual to obtain the
best performance from this equipment.
Thank you for considering and purchasing FURUNO.

Features
This Live Player V5 is a software program that installs in a PC, and functions to monitor and playback the data collected in the VR-7000’s DRU, Long Term Device.

Notes on usage
Observe the notices shown below to prevent malfunction.
• Do not connect the Live Player to a DRU (Fixed, Float-free) when the DRU is connected to the
DCU. Also, do not attempt to extract data in the above-mentioned condition.
• The Live Player of the VR-3000 is not compatible with the VR-7000. Do not use it with the VR7000.
• The screenshots shown in this manual were taken on a Windows®7 based PC. The screens
you see may be different depending on your PC’s OS.
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1.

INSTALLATION

1.1

Requirements
Live Player V5 components
• Software program CD

• Documentation

• LAN cable (supplied)

Recommended specifications for replay PC
•
•
•
•
•
•
•
•
•

CPU: Pentium 350 MHz (or equivalent) or higher
RAM: Minimum 1 GB
HDD: Minimum 250 GB
Screen resolution: XGA or higher (More than SXGA (1280x1024) recommended)
Operating system: 32 bit Windows®7, Windows®8*, Windows Vista®, Windows®XP
Professional SP2. English or Japanese OS only.
*32 or 64 bit.
CD-ROM drive (internal or external)
LAN port
DirectX®9.0c or higher
Java®7.25 (If there is no Java® in the PC or the Java® is outdated, install the Ja-

va® program from the accessory CD.)
• Microsoft® Visual C++® 2005 SP1 Redistributable Package (x86)
Before you connect a PC to the VDR, set the IP address and subnet mask on the
PC and set the internet options of Internet Explorer®. The IP address of the VR-7000
is 172.31.16.200.

1.2

How to Install the Live Player V5
The software program for the Live Player V5 is included in the accessory CD. Install
the program in the PC as directed in the applicable procedure in this section.

1.2.1

Windows®7
Deactivate the firewall
Deactivate the firewall to install and operate the Live Player V5 program.
1. Click the [Start] button to open the [Control Panel].
2. In the search box, type firewall, and then click [Windows Firewall].
3. In the left pane, click [Turn Windows Firewall on or off].
4. Click [Turn off Windows Firewall] then click [OK].
If you try to use the Live Player V5 with the firewall active, the following occurs:
• VDR settings cannot be downloaded when the Live Player V5 is connected.
• Data cannot be replayed when the Long Term Device is connected to LAN. Data
extraction and analysis also are not possible.
To reactivate the firewall, click [Turn on Windows Firewall] at step 4 in the procedure.
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Install the software
1. Insert the program CD into the CD drive.
2. Run view.exe on the program CD to show the Setup-VR-7000 dialog box.
3. Click the [Next] button.
4. Confirm that the install location is “C:\Program Files\FURUNO” then click the
[Next] button.
5. Click the [Yes] button.
6. Click the [Next] and [Install] buttons to install the software.
7. After the installation is completed, the message “Yes, restart computer now” is
checked. Click the [Finish] button to complete the installation and restart the PC.

Grant administrator access
Full administrator access is necessary to install and run the Live Player program.
Grant administrator access as follows:
1. Right click on the program shortcut then click [Properties].
2. In the [Properties] window, go to the [Compatibility] tab.
3. At [Privilege Level], check [Run this program as an administrator] then click the
[OK] button.

1.2.2

Windows®8
Deactivate the firewall
Deactivate the firewall to install and operate the Live Player V5 program.
1. Login to Windows®8 user account.
2. Point mouse to lower right corner of the screen to display a sidebar.
3. Click the [Control Panel] option on the sidebar to open the Control Panel.
4. Click the [System and Security] option then click [Windows Firewall].
5. Click [Turn Windows Firewall on or off] at the left side of the window.
6. Click the radio button [Turn off Windows Firewall (not recommended)] under both
the private and public network settings.
7. Select [OK].
If you try to use the Live Player V5 with the firewall active, the following occurs:
• VDR settings cannot be downloaded when the Live Player V5 is connected.
• Data cannot be replayed when the Long Term Device is connected to LAN. Data
extraction and analysis also are not possible.
To reactivate the firewall, click [Turn on Windows Firewall] at step 6 in the procedure.

Install the software
1. Insert the program CD into the CD drive.
2. Run view.exe on the program CD to show the Setup-VR-7000 dialog box.
3. Click the [Next] button.
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4. Confirm that the install location is “C:\Program Files*\FURUNO” then click the
[Next] button.
* Folder name for 32 bit. “Program Files(x86)” for 64 bit.
5. Click the [Yes] button.
6. Click the [Next] and [Install] buttons to install the software.
7. After the installation is completed, the message “Yes, restart computer now” is
checked. Click the [Finish] button to complete the installation and restart the PC.

Grant administrator access
Full administrator access is necessary to install and run the Live Player V5 program.
Grant administrator access as follows:
1. Right click on the program shortcut then click [Properties].
2. In the [Properties] window, go to the [Compatibility] tab.
3. At [Privilege Level], check [Run this program as an administrator] then click the
[OK] button.

1.2.3

Windows Vista®
Deactivate the firewall
1. Click the [Start] button.
2. Click [Control Panel], [Security] and [Windows Firewall].
3. Choose [Turn Windows Firewall on or off].
4. Select [Off (not recommended)]. Click [OK].
If you try to use the Live Player V5 with the firewall active, the following occurs:
• VDR settings cannot be downloaded when the Live Player V5 is connected.
• Data cannot be replayed when the Long Term Device is connected to LAN. Data
extraction and analysis also are not possible.
To reactivate the firewall, click [On] at step 4 in the procedure.

Install the software
1. Insert the program CD into the CD drive.
2. Run view.exe on the program CD to show the Setup-VR-7000 dialog box.
3. Click the [Next] button.
4. Confirm that the install location is “C:\Program Files\FURUNO” then click the
[Next] button.
5. Click the [Yes] button.
6. Click the [Next] and [Install] buttons to install the software.
7. After the installation is completed, the message “Yes, restart computer now” is
checked. Click the [Finish] button to complete the installation and restart the PC.

Grant administrator access
Full administrator access is necessary to install and run the Live Player V5 program.
Grant administrator access as follows:
1. Right click on the application's shortcut icon.
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2. Select [Properties] on the menu.
3. Click the [Advanced] button under the Shortcut tab in the dialog box.
4. Check the [Run as administrator] box.
5. Click the [OK] button. Finish by clicking [Apply ]and then [OK].

1.2.4

Windows®XP
Deactivate the firewall
1. Click [Start], [Settings], [Control Panel] and open [Network Connections].
2. In the [Network Connections] window, right click [Local Area Connection] and select [Properties].
3. In the [Local Area Connection Properties] window, click the [Advanced] tab.
4. Uncheck [Protect my computer and network by limiting or preventing access to
this computer] from the [Internet] option then click the [OK] button.
If you try to use the Live Player V5 with the firewall active, the following occurs:
• VDR settings cannot be downloaded when the Live Player V5 is connected.
• Data cannot be replayed when the Long Term Device is connected to LAN. Data
extraction and analysis also are not possible.
To reactivate the firewall, check [Protect my computer and network by limiting or preventing access to this computer] at step 4 in the procedure.

Install the software
1. Insert the program CD into the CD drive.
2. Run view.exe on the program CD to show the Setup-VR-7000 dialog box.
3. Click the [Next] button.
4. Confirm that the install location is “C:\Program Files\FURUNO” then click the
[Next] button.
5. Click the [Yes] button.
6. Click the [Next] and [Install] buttons to install the software.
7. After the installation is completed, the message “Yes, restart computer now” is
checked. Click the [Finish] button to complete the installation and restart the PC.

Grant administrator access
Full administrator access is necessary to install and run the Live Player V5 program.
Grant administrator access as follows:
1. Right click on the application's shortcut icon.
2. Select [Properties].
3. Click the [Compatibility] tab.
4. At [Privilege Level], check [Run this program as an administrator] then click the
[OK] button.
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1.3

How to Set the PC
Before you connect the PC w/Live Player to the VDR, set the IP address and subnet
mask on the PC and set the internet options of Internet Explorer®. The IP address of
the VR-7000 is The IP address of the VR-7000 is 172.31.16.200.

1.3.1

Windows®7
1. Click the [Start] button then click [Control Panel].
2. In the search box, type adapter.
3. Under [Network and Sharing Center], click [View network connections].
4. Right click the connection to change, and then click [Properties].
5. Click the [Networking] tab. Under [This connection uses the following items], click
[Internet Protocol Version 4 (TCP/IP v4)] then click [Properties].
6. Click the [Use the following IP address] button.
7. Enter the IP address and subnet mask of the PC:
IP address: 172.31.16.201 or 172.31.16.202 (other than 172.31.16.200)
Subnet mask: 255.255.0.0
8. Click the [OK] button and then click the [Close] button.
9. Restart the PC.

1.3.2

Windows®8
1. Move the mouse cursor to the bottom or top right corner of the screen and select
the cog icon for [Settings].
2. Select [Control Panel].
3. In the [Control Panel] window, select [Category] and then select Large or Small
icons.
4. Select [Network and Sharing Center].
5. Select [Change adapter settings].
6. Right click on your connected network and select [Properties].
7. Select [Internet Protocol Version 4 (TCP/IP v4)] then click [Properties].
8. Click the [Use the following IP address] button.
9. Enter the IP address and subnet mask of the PC:
IP address: 172.31.16.201 or 172.31.16.202 (other than 172.31.16.200)
Subnet mask: 255.255.0.0
10. Click the [OK] button and then click the [Close] button.
11. Restart the PC.

1.3.3

Windows Vista®
1. Click the [Start button]. Right click [Network] then [Properties].
2. The [Network and Sharing Center] opens; click on [Manage network connections].
3. Right-click on the network to assign an IP address and click [Properties].
4. Highlight [Internet Protocol Version 4 (TCP/IP v4)] then click [Properties].
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5. Select [Use the following IP address] and enter the IP address and subnet mask
of the PC.
IP address: 172.31.16.201 or 172.31.16.202 (other than 172.31.16.200)
Subnet mask: 255.255.0.0
6. Click the [OK] button and then click it again on the next screen.
7. Restart the PC.

1.3.4

Windows®XP
1. Click [Start], [Settings], [Control Panel], [Network Connections]. Right click the
network connection to configure then click [Properties].
2. On the [General] tab, click [Internet Protocol (TCP/IP)] then click [Properties].
3. Click [Use the following address].
4. Enter the IP address and subnet mask of the PC:
IP address: 172.31.16.201 or 172.31.16.202 (other than 172.31.16.200)
Subnet mask: 255.255.0.0
5. Click the [OK] button and then click it again on the next screen.
6. Restart the PC.

1.3.5

Internet Explorer®
1. Open Internet Explorer®, and then select [Internet Options] from the [Tools] menu.
2. Click the [General] tab, and then click the [Settings] button in the [Browsing history] window.
3. Select [Every time I visit the webpage] in [Check for newer versions of stored pages].
4. Click the [OK] button.
5. Click the [Apply] button.
6. Click the [OK] button.
Note: If an error page or previously displayed page appears, do [Delete Files] at the
[Browsing history] window.
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1.4

How to Connect a PC to the VR-7000
Open the door on the cover of the DCU. Connect the LAN cable (supplied) between
the DATA port J502 in the DCU and the LAN port on the PC.
DCU

Data port
J502
LAN
cable

PC

LAN port

1.5

How to Start the Live Player V5
Windows®7: [Start] button > [All Programs] > [VR-7000] > [Live Player V5]
Windows®8: [Start] screen > Right click a blank part of screen then select [All Apps]
> click “VR-7000”
Windows Vista®: [Start] button > [All Programs] > [VR-7000] > [Live Player V5]
Windows®XP: [Start] button > [All Programs] > [VR-7000] > [Live Player V5]
Note 1: When a symptom shown below occurs, reboot the Live Player.
• A Java® 7.25 related error occurs and Live Player shuts down.
• The Live Player shuts down when maximizing or minimizing a dialog box.
• The error message "[OPERATION] Processing speed decrease. It has already started. [1 process]" appears.
• The track list does not appear (source selected from [Source Select] window; [Analyze] button clicked) after several minutes.

Note 2: If the PC requests a restart while the Live Player is starting up, do one of the
following to restore normal operation. (The procedure may be slightly different depending on your OS.)
• Open the Task Manager then select the [Processes] tab. Check [Show processes
from all users]. Select “rserv.exe”, then click the [End Process] button. “rserv.exe” is
then automatically restarted.
• Restart the PC.
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1.6

How to Uninstall the Live Player V5
Login as the administrator to uninstall the Live Player.

1.6.1

Windows®7, Windows Vista®
1. Click [Start] button > [Control Panel] > [Programs] > [Programs and Features].
2. Select “VR-7000” then click [Uninstall].

1.6.2

Windows®8
1. Hover the cursor in the bottom-left corner of the screen until a small image of the
Start Screen appears, then right-click on the icon to open the [Start Context]
menu. Select [Programs and Features] menu then [Select Programs and Features].
2. Select “VR-7000” then click [Uninstall].

1.6.3

Windows®XP
1. Click [Start] button > [All Programs] > [VR-7000] > [VR-7000 Uninstall].
Uninstall the software following the wizard shown on the display.
2. Delete the VR-7000 folder saved in the [My Computer] > [Local Disk (C:)] > [Program Files\FURUNO] folder.
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2.

PLAYER CONFIGURATION
The user can configure the layout and the data to display. The configuration can be
saved and copied as a file, which can be loaded to another PC to share the same layout. In addition, the configuration can be saved in a capsule for use as the default layout for replay and live play.

2.1

Display Configuration

2.1.1

Configuration overview
Display title area
Menu area
Status area

Control area
Data tabs

View area

Connection information display area

Display title area: The application name, “Live Player V5”, appears here.
Menu area: The system menu.
Status area: Shows common data (FURUNO logo, time at server, etc.). The time at
the server is updated at regular intervals.
Control area: The operation buttons related to the contents of the view area appear
here.
View area: Select the data to show with the data tabs.
Connection information display area: Server status is displayed.

2-1

2. PLAYER CONFIGURATION

2.1.2

Menu area, status area, control area

No.
Item
Menu area
1
Menu

Status area
2
System time,
local time
3
Product name
4
RAP STATUS

5

POWER
STATUS

Control area
6
Track control
panel

7

Play control
panel

Description
[File]: Opens VDR configuration, exit application.
[Tool]: Selects various tools: [Source Select], [Volume], [Extract], [Analyze], Alert Display, [Buzzer Setting], [Alert Popup], [Audio], [Password],
[Serial Output], [Backup].
[Configuration]: Turns the configuration mode on or off; displays Sheet list,
Decoder library, Alert definition list, Viewer configuration management (import/export/download/upload), VDR Config.
[Help]: Displays the program version information.
System time and local time.
VR-7000
Alert status is shown with colored and lighting or flashing lamps.
[NORMAL]: Lights green when there are no unacknowledged or unrectified
alerts.
[ALERT]: Lights or flashes red for unacknowledged or unrectified alert.
Alert status and lamp state and color:
Unacknowledged alert: Flashes red.
Unrectified alert: Lights red.
Unacknowledged but rectified alert: Flashes red.
[BATT]: Battery status appears.
[AC]: AC power status.
For either indicator: Green: Normal, Red: Error
Selects the track to playback.
W: Replace the played back track with one track number younger than the
played back track.
Track: Display currently selected track number. “-” appears when no track
is selected.
X: Replace played back track with next sequential track.
Control track playback. For the 8x playback speed, asterisks may appear in
the data. This is not a sign of malfunction. If necessary, lower the playback
speed to remove the asterisks.
x 1.0 ▼: Select playback speed. ■: Stop playback.
►: Play back data, pause playback.

8

Time panel

9

Time control
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Display various times.
Start time: Display the time when the recording of the selected track started.
Play time: Display the time when the recording of currently played back
track started.
End time: Display the time when the recording of the currently played back
track was stopped.
Set the start time for playback. The time at the slider position appears in the
time panel.

2. PLAYER CONFIGURATION

2.1.3

View area
The items shown in the view area changes according to the mode selected, with
[Source Select] in the [Tool] menu.

172

No.
1

Item
Mode
drop-down list

2

Launch configuration

3

[Connect]
button

4

[Cancel] button

5

Checkbox: Automatically
download viewer Configuration.

0
31

0
16

100
200

Function
There are two main modes (Live and Extract (Playback)) and four sub modes (Fixed DRU, Float DRU,
Long Term Device (Direct), and Long Term Device
(LAN)).
The dialog box appears at the start up of the application. Check this box to hide the dialog box at start up.
Click the button to connect to the VDR/Long Term Device. If the connection could not be made, an error
message appears. After the connection is made the
base display for the mode selected appears.
Click the button to finish current display and return to
the base display.
Check to automatically download viewer configuration to the connection source (DCU or DRU). Can also
be used for playback.
Previously downloaded configuration is written over
each time new configuration data is downloaded.
If the configuration data is abnormal, an error message appears and no downloading occurs.
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2.2

How to Create a New Configuration Page
Do the procedure in this section to create a new player configuration page. The window title bar complies with the general standard for Microsoft GUI.
Note 1: Stop Replay or Live Play before creating a new player configuration page. If
the LAN cable is disconnected, Replay or Live Play stops, however they are still active. In this case, restart the Live Player V5 and create a new player configuration
page.
Note 2: A part of the conning display may be hidden when scrolling the display. If this
occurs, change the component placement.
1. Open the [START] menu and click [Program] > [VR-7000] > [Live Player V5].
2. Click the [Cancel] button in the [Source Select] dialog box.
3. Click [Configuration] > [Configuration Mode] > [ON].
The program provides the following data sheet. However you can make a customer’s data sheet. Proceed to step 4.
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4. Click [Configuration] > [Sheet] to show the [Sheet List] dialog box.

5. Click the [Add] button to show the [Sheet Property] dialog box.

6. Select a tab icon from the [Sheet Icon] drop-down list as appropriate.

GRW
WUXPSHW
7. Enter a name for the tab in the [Title] field.
8. Click the drop-down list at [Sheet Type].
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9. Select a suitable template for the page layout, and the template selected appears
in the [Example] window.
The template [FullSetSheet], shown below, provides the graphical objects. The
[DefaultEmptySheet] provides a blank sheet from which to create a template from
scratch.

Example: FullSetSheet
10. Click the [OK] button to close the [Sheet Property] dialog box.
11. Click the [OK] button to close the [Sheet List] dialog box. The new tab appears at
right side of the tab list.
A new tab added

12. Go to the next section to set each data box.
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2.3

Making a User-specified Graphical Form

2.3.1

Arranging graphical sheet
To create a graphical form, do as follows:
1. Right click on an empty panel to show the context-sensitive menu.
2. Click the [Add] button to show the [Component Select] dialog box.
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3. Click the arrow on the drop-down list and select (click) the object desired you wish
to display. In the example shown below, [CompassSheet] is selected.

4. Click the [OK] button. In the example shown below, the compass sheet is displayed.

5. Right click on an empty panel again to show the panel menu and repeat steps 2
to 4 to select other objects. There are 15 objects: [Compass Sheet], [Dial Meter
Sheet], [Doppler Log Sheet], [Dual Dial Meter Sheet], [Graph Sheet], [Horizontal
Bar Sheet], [Horizontal Ruler Sheet], [Wind Direction Sheet], [Numeric Data Display Sheet], [Pitch and Roll Sheet], [Rudder Sheet], [Vertical Bar Sheet], [Radar/
AIS], [Azimuth Promotion Sheet], and [Two Dimension Plotter Sheet].
z The position of a sheet can be changed. Locate the pointer on a sheet and dragand-drop it.
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Example of panel layout

2.3.2

Configuration of graphical object
There are 15 objects. Configure each graphical object as described in the next several
sections. To display each [Component Properties] dialog box, right click each object
and select [Property]. To show input signal data, set various items in the [Property] dialog box. However, the Radar/AIS sheet has no items to set.

2-9

2. PLAYER CONFIGURATION

2.3.3

Compass sheet
General tab

The leftmost tab on any sheet is called the [General] tab, and it contains the parameters common to all graphical objects.
[Title]:
Enter text that is displayed in the graphical object.
[Gauges]:
Check the check box to enable the display of gauges defined for that graphical object.
(This setting is invalid for Two Dimension Plotter Sheet.)
[OK] button:
After setting all items, click the button to finish configuring all objects.
[Apply] button:
Show effect after setting.
[Close] button:
Close the sheet.
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Compass tab

[Scale]:
[Format]: Define the format of the figures on the compass dial. See paragraph 2.3.17.
[Sources]:
[Primary]: Select the primary data source to control the rotation of the compass dial.
[Secondary]: Select the secondary data source (optionally) to control the small triangle
circling on the compass dial.
Click the [Setup] button to display the source setting dialog box.
Open the [Analog], [Digital], [Sensor(LAN)] or [Serial] tab according to the input signal
connected.
For the compass sheet, open the [Serial] tab and set HDG or HDT to show ship’s
heading data.
[Colors]:
The parameters in this window control the appearance of the dial meter. The [Set to
Default] resets all the colors to the default definition. See paragraph 2.3.16.

2-11

2. PLAYER CONFIGURATION

2.3.4

Dial Meter and Dual Dial Meter sheets
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Dial Meter tab

Scale Resolution

[Labels]:
[Dial Title]: Text located immediately over the dial meter.
[Unit]: Text located inside the dial.
[Scale]:
This window contains the parameters for controlling the geometry and resolution of the
dial.
[Start Value]: The start value corresponds to the most counterclockwise point on the
dial. [End Value]: The end value corresponds to the most clockwise point on the dial.
[Format]: Define the format of the figures on the dial, see paragraph 2.3.17.
[Angle]: Define the extent of the dial.
[Rotation]: In default setting, the dial will be oriented like a typical speedometer in a
car. The operator may change the orientation by selecting a value other than 0 from
the drop-down list.
[Scale Resolution]: This parameter controls the graduation of the dial.
[Show Mathematical Sign]: This parameter controls whether figures on the dial are displayed with sign or without sign.

2-12

2. PLAYER CONFIGURATION

Example of settings for dual dial meter
[Sources]:
[Primary]: Input to the pointer for the dial meter.
[Secondary]: Input to the secondary indicator for the dial meter. The secondary indicator is shown as a small triangle. The secondary indicator is typically used for displaying the “commanded value” while the main indicator shows the actual value.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the appearance of the dial meter. The [Set to
Default] resets all the colors to the default definition. See paragraph 2.3.16.

2.3.5

Doppler (log) sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Doppler (log) tab
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[Numeric Output]:
[Unit]: Text displayed after all numeric outputs, e.g., Kn.
[Format]: Define the format of the numeric outputs. See paragraph 2.3.17.
[Mathematical Sign]: This parameter controls whether the numeric outputs are displayed with sign or without sign.
[Sources]:
Four inputs may be applied to the Doppler log object.
[Longitudinal Speed]: Shown as numeric data in the center of the sheet.
[Bow Transverse Speed]: Shown as numeric data at the bottom of the sheet.
[Stern Transverse Speed]: Shown as numeric data at the top of the sheet.
[Relative Wind Direction]: Shown as a triangle circling the center of the sheet.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.4.
[Colors]:
The parameters in this window control the appearance of the object. The [Set to Default] button resets all the colors to the default definition. See paragraph 2.3.16.

2.3.6

Graph sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Graph tab
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[Graph type]:
This window defines the input to the X-coordinate for the graph object.
[Time/Y graphs]: The primary and secondary are used as Y-coordinate for two independent graphs. The time is used as the X-coordinate for both graphs.
[X/Y graph]: The primary input is used for the X-coordinate and the secondary for the
Y-coordinate.
[Resolution]:
This window defines the resolution of the graph(s). Small values for “Time Span” and
“Sample Interval” provide a graph with high resolution while high values provide a
graph that covers a large time span.
[Labels]:
[Label]: Labels for numeric output.
[Unit]: Text displayed after numeric output and Y-axis, and X-axis if X/Y graph is selected.
[Scale]:
This window defines the resolution for the Y-axis and the X-axis in case of X/Y graph
and Y-axis in case of Time/Y graph.
[Sources]:
[Primary]: Set the primary data source for Y1 axis or Y-axis.
[Secondary]: Set the secondary data source for Y2 axis or X-axis.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the colors of the graph. The [Set to Default] button resets all the colors to the default definition. See paragraph 2.3.16.
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2.3.7

Horizontal bar sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3. To display
two horizontal bars, check two check boxes in the [Gauges] window in the General
tab.
The parameters for the horizontal bar correspond to the parameters for vertical bar.
An extra label (middle) has been added.

Horizontal Bar tab

[Labels]:
A vertical bar has two labels, one at each end. One of them is typically used as a description while the other indicates units.
[Scale]:
[Start Value]: The start value corresponds to the bottom of the bar.
[End Value]: The end value corresponds to the top of the bar.
[Mirror Vertically]: In the default setting, two adjacent bars are two symmetrical instances of the bar object, that is, bar 1,2 and 3,4 form two pairs. The operator may
change this by, for example, “horizontally mirror” bar object 1 and 3.
[Format]: Define the format of the figures for the bar object. See paragraph 2.3.17.
[Show Mathematical Sign]: This parameter controls whether figures related to the bar
object are displayed with sign or without sign.
[Sources]:
[Primary]: Input to the main indicator for the bar object.
[Secondary]: Input to the secondary indicator for the bar object. The secondary indicator is shown as a small triangle. The secondary indicator is typically used for displaying the “commanded value” while the bar shows the actual value.
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The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
Parameters in this window control the appearance of the bar object. The [Set to Default] button resets all the colors to the default definition. See paragraph 2.3.16.
Note: To show the title on the horizontal bar, uncheck [Show Horizontal Bar 1] on the
[General] tab and enter a name at the [Title] box.

2.3.8

Horizontal ruler sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Horizontal ruler tab

[Labels]:
A horizontal bar has 6 labels.
[Scale]:
[Start Value]: The start value corresponds to the far-left point of the ruler.
[End Value]: The end value corresponds to the far-right point of the ruler.
[Format]: Define the format of the figures on the ruler object. See paragraph 2.3.17.
[Show Mathematical Sign]: The parameter controls whether figures related to the ruler
object are displayed with sign or without sign.
Mirror Vertically: In the default setting, two adjacent bars are two symmetrical instances of the bar object, that is, bar 1,2 and 3,4 form two pairs. The operator may change
this by, for example, “horizontally mirror” bar object 1 and 3.
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[Sources]:
[Primary]: Input to the main indicator for the bar object. The main indicator is shown
as a triangle above the ruler.
[Secondary]: Input to the secondary indicator for the bar object. The secondary indicator is shown as a triangle below the ruler. The secondary indicator is typically used
for displaying the “commanded value” while the primary indicator shows the actual value.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
Parameters in this window control the appearance of the ruler object. The [Set to Default] button resets all the colors to the default definition. See paragraph 2.3.16.

2.3.9

Wind direction sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Wind Direction tab

[Labels]:
[Wind Speed Unit]: Text shown at wind speed indication.
[Wind Direction Unit]: Text shown at wind direction indication.
[Scales]:
[Wind Speed Format]: Define the format of the numeric outputs. See
paragraph 2.3.17.
[Wind Direction Format]: Define the format of the numeric outputs. See
paragraph 2.3.16.
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[Sources]:
[Log]: Set the data source of own ship speed. The typical input is data from the Speed
log sensor.
[True Wind Direction]: Set the data source of true wind direction.
[True Wind Speed]: Set the data source of true wind speed.
[Relative Wind Direction]: Set the data source of relative wind direction.
[Relative Wind Speed]: Set the data source of relative wind speed.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the appearance of the object. The Set to Default button resets all the colors to the default definition. See paragraph 2.3.16.

2.3.10

Numeric data display sheet

The Numeric Data Display does not display any gauges. Three smaller “objects” for
displaying numeric data or text are displayed instead. These smaller objects, called
“Graphical standard objects”, are almost identical to the non-graphical standard objects defined for showing data in tabular form.
Note that the overall title for the graphical object may interfere with the [Graphical
Standard Object 1].
The color of the label text for a “Graphical Standard Object” is determined by the default color definition (Text/Outline Color). See paragraph 2.3.16. The “Primary indicator color” is used as default for the displayed data but may be set by the operator.
A number of Numeric Data Displays may be linked by removing adjacent lines.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
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2.3.11

Pitch and roll sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Pitch and Roll tab

Gauge

Scale

[Gauge]:
[Title]: Text shown above the gauge.
[Type]: Used to select gauge type (pitch or roll). Pitch is default for gauge 2; roll is default for gauge 1.
[Scale]:
[Format]: Define the format of the numeric outputs. See paragraph 2.3.17.
[Show Mathematical Sign]: This parameter controls whether figures on the dial are displayed with sign or without sign.
[Source]:
[Source]: Set the data source of pitch and roll. The typical input is data from the rudder
angle sensor.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the appearance of the object. The Set to Default button resets all the colors to the default definition. See paragraph 2.3.16.

2-20

2. PLAYER CONFIGURATION

2.3.12

Rudder sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Rudder tab

Scale Resolution

[Labels]:
[Title]: Text shown beneath the rudder indicator.
[Scale]:
[Rudder Max Angle]: This parameter controls the extent of the dial for the object. It is
recommended that a value equal to the maximum rudder angle for vessel be used.
[Scale Resolution]: Select scale resolution
[Show Mathematical Sign]: The parameter controls whether figures on the dial are displayed with sign or without sign.
[Sources]:
[Primary]: Set the primary data source of rudder angle. The typical input is data from
the rudder angle sensor. Secondary: Set the secondary data source of rudder angle
(optionally). The typical secondary input is “Commanded rudder angle”
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the appearance of the object. The [Set to Default] button resets all the colors to the default definition. See paragraph 2.3.16.

2-21

2. PLAYER CONFIGURATION

2.3.13

Vertical bar sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Bar1 tab

[Labels]:
A vertical bar has two labels, one at each end. One of them is typically used as description while the other indicates units.
[Scale]:
[Start Value]:The start value corresponds to the bottom of the bar.
[End Value]: The end value corresponds to the top of the bar.
[Format]: Define the format of the figures for the bar object. See paragraph 2.3.17.
[Mirror Horizontally]: In the default setting, the adjacent bars are two symmetrical instances of the bar object, that is, bar 1,2 and 3,4 form two pairs. The operator may
change this by, for example, “horizontally mirror” bar object 1 and 3.
[Show Mathematical Sign]: This parameter controls whether figures related to the bar
object are displayed with sign or without sign.
[Sources]:
[Primary]: Input to the main indicator for the bar object.
[Secondary]: Input to the secondary indicator for the bar object. The secondary indicator is shown as a small triangle. The secondary indicator is typically used for displaying the “commanded value” while the bar shows the actual value.
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The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the appearance of the bar object. The [Set to
Default] button resets all the colors to the default definition. See paragraph 2.3.16.

2.3.14

Azimuth Promotion sheet
The setting of the [General] tab is similar to that shown in paragraph 2.3.3.

Azimuth Promotion tab

[Direction]:
[North Angle]: Enter north angle relative to the screen.
[Sources]:
[Primary]: Set the data source of bearing data. Moving direction is displayed. The [Setup] button opens a dialog box where the source data may be defined. See section 2.3.
Set a direction signal from the serial data sentence, for example, HDG, HDT, MWV,
VHW, VTG, etc.
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2.3.15

Two Dimension Plotter sheet
The setting of the General tab is similar to that shown in paragraph 2.3.3.

Two Dimensions Plotter tab

[Resolution]:
[Time Span]: Enter time span for plotter screen.
[Sample Interval]: Enter sample interval for plotter screen.
[Labels]:
[Primary]: The label and unit of X-axis.
[Secondary]: The label and unit of Y-axis.
[Scales]:
[Max Value (X)]: Set maximum value for X-axis.
Max Value (Y): Set maximum value for Y-axis.
[Show Tick Label]: Check to show tick label.
[Scale Resolution]: Select scale resolution, among coarse, medium and fine.
[Axis Point]:
[X Value]: Enter starting point of X-axis.
[Y Value]: Enter starting point of Y-axis.
[Axis Type]:
[Axis Type]: Select axis type between Under-left and Central. The Central shows center of the coordinates to center of the screen.
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[Plotter Image]:
[Symbol]: Select symbol for the ship among ship, circle, triangle, and cross.
[Sources]:
[Primary]: Set the primary data source for X1 and Y1 axes.
[Secondary]: Set the secondary data source for X1 and Y1 axes.
The [Setup] button opens a dialog box where the source data may be defined. See
section 2.3.
[Colors]:
The parameters in this window control the appearance of the bar object. The [Set to
Default] button resets all the colors to the default definition. See paragraph 2.3.16.

2.3.16

Color definition
To define the color for an item, click the color box on each sheet to open the [Color
Select] dialog box.

Click an appropriate color on the color palette to select it. Click appropriate tab ([HSV],
[HSL], [RBG], [CMYK]) to see your color selection and further adjust the color. The example below is the [Swatches] tab.
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2.3.17

Formatter syntax
Figures displayed by the graphical objects may be formatted, that is, the number of
digits after the decimal point and leading zeroes may be defined.
The formatter syntax is identical to the syntax defined for formatting output from an
NMEA decoder.
Example: 7.5 and 10 can be shown three different ways depending on the formatter
used.
Formatter
0
0.0
000

2.3.18

Display “7.5”
Display “10”
Result
7
10
7.5
10.0
007
010

Radar/AIS sheet
There is no item to be set on the [Radar/AIS] sheet. Use W or X to select the image
to show, among Radar1/Radar2/ECDIS/Additional. The example below shows a radar
image.
To show the AIS screen, click [AIS] button at the upper right corner.
The [Information] button provides textual information about the image shown.

2-26

2. PLAYER CONFIGURATION

2.4

Setting of Source Data
Select the source to use to show the respective data on each sheet. Before setting the
source data, make a memo about connection channel and input signal.
Click the [Conning] tab. Right-click any sheet other than the [Radar/AIS] sheet then
select [Properties]. Click the [Setup] button in the [Component Properties] dialog box
to show the [Data Source Select] dialog box. Click the applicable tab among [Analog],
[Digital], [Serial], and [Sensor (LAN)].

Analog tab

[Source], [Target]:
Set the channel of the input sensor that you want to use to show analog data. The setting range is from AN001 to AN120.
[Factor]:
To apply a factor (multiplier) to the original data, check the [Use Factor] check box and
enter a factor. For example, enter 0.514 for speed data to convert knots to m/s.
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Digital tab

[Source], [Target]:
Set the channel of the input sensor that you want to use to show digital data. The setting range is from DC001 to DC640.
[Alternative Value]:
To use an alternative value, check the [Use alternative values]. If not checked, the text
entered at installation appears in the [Active value] box and [Inactive value] box.
Example
For alert signal of [Normal Close]
[Active value] to [Normal]
[Inactive value] to [General alert] or [Fire alert]
For steering gear run indicator signal of [Normal Open]
[Active value] to [Run]
[Inactive value] to [Stop]
[Factor]: To use a factor, check the [Use Factor] check box and enter a signal factor.
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Serial tab
The serial signal means IEC61162 or NMEA0183 format signal.

[Source], [Target]:
Set the channel of the input sensor that you want to use to show serial data. The setting range is from SI01 to SI72. (SI17 and higher are no use.)
[Decoder]:
Set data type.
[Use Timeout]:
To use timeout functions, check the [Use Timeout] box and enter a time from 1 to 60
seconds. For multiple like data sources set the same use timeout for each.
[Use Check Sum]:
Check this box to use the check sum that is included in serial data.
[Factor]:
To use a factor, check the [Use Factor] check box and enter a signal factor.
To add a data sentence:
1. Click the [Library] button to show the [Decoder Library] dialog box.
2. Click a data (NMEA sentence) desired in the decoder library (left-hand window of
the [Decoder Library] dialog box). This library supports all the sentences specified
in IEC 61996. If a sentence that is not supported by this library is input to the VR7000, you can create and edit a new decoder for the sentence. See chapter 5 for
how to create a new decoder.
3. Click the [OK] button, and the data sentence appears in the [Standard-Object
Properties] dialog box.
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Sensor (LAN) tab

[Source], [Target]:
Set the channel of the input sensor that you want to use to show Sensor (LAN) data.
The setting range is from LN01 to LN64.
[Decoder]:
Set data type.
[Use Timeout]:
Check the [Use Timeout] box and enter time from 1 to 60 seconds. For multiple like
data sources set the same use timeout for each.
[Use Check Sum]:
Check this box to use the check sum that is included in serial data.
[Factor]:
To use a factor, check the [Use Factor] check box and enter a signal factor.
To add a data sentence:
1. Click the [Library] button to show the [Decoder Library] dialog box.
2. Click a data (NMEA sentence) desired in the decoder library (left-hand window of
the [Decoder Library] dialog box). This library supports all the sentences specified
in IEC 61996. If a sentence that is not supported by this library is input to the VR7000, you can create and edit a new decoder for the sentence. See chapter 5 for
how to create a new decoder.
3. Click the [OK] button, and the data sentence appears in the [Standard-Object
Properties] dialog box.

2-30

2. PLAYER CONFIGURATION

2.5

Saving the Configuration
You can save the configuration to a DRU or Long Term Device.
Note 1: When the error message "[CONN] Could not upload ***.tar" appears when
saving the configuration, check the connection of the DRU and Long Term Device,
and then save the configuration.
Note 2: When the DRU (Fixed, Float), Long Term Device and CF do not have the configuration data and you click the [Refresh] button, the error message "[CONN] Could
not Refresh" or "[CONN] could not Download" is shown. In this case, reboot the Live
Player V5.

To save the configuration created to the replay PC
Connect the replay PC to the DCU, Long Term Device as shown in section 3.1.1 then
do as follows.
1. Click [Configuration] on the menu bar then select [Configuration Model] > [OFF].
The message "Save Viewer Config?" appears.
2. Click the [Yes] button to save the viewer configuration.
3. Click [Configuration] > [Viewer Config Management] to show the Viewer Config
Management dialog box.

4. Click the [Export to] button.
5.

Enter a file name, select a file save location and click [Save] button.

6. Click the [OK] and [Close] buttons.
Note: Turn Configuration OFF and save the setting data. Restart the Live Player V5
to reflect the setting data.
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To save the configuration to the DRU, long term device
1. Click [Configuration] on the menu bar then select [Configuration Mode] > [OFF].
2. Click the [Yes] button.
3. Click [Configuration] > [Viewer Config Management] to show the [Viewer Config
Management] dialog box.
4. Click the [Upload] button to open the [Upload] dialog box.
5. Click the [Select] button and enter name for the file in the [File name] box.
6. Select where to save the file then click the [Open] button.
7. Click the [OK] button twice.
8. Click the [OK] and [Close] buttons.
Note that you can load the configuration data from the DRU to another PC.
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EXTRACTING, REPLAYING DATA
The replay function is specially designed for data analysis after an incident, with the
recording stopped. (Do not access the DRU while it is recording.) Playback is possible
while recording, by connecting to the Long Term Device via LAN.
Note: Recording is terminated only in the following instances:
• During essential maintenance purposes while the vessel is in port.
• The vessel is dry-docked.
To stop recording, turn off the BATTERY BACK-UP and AC SUPPLY MAINS switch
in the DCU in that order. DO NOT turn off the system by the main breaker while the
BATTERY switch is on. If this is done, the system operates on the batteries. The system stops after running on batteries for two hours.
There are two ways to replay the data recorded:
1) Connect the DRU directly to a PC after it is removed from the DCU. (This is not
possible with the fixed DRU.)
2) Reading the data retrieved from the DRU or the Long Term Device.
Note 1: Do not remove the Long Term Device(s) from the DCU unless authorized to
do so. Extract data to a PC or when necessary.
Note 2: If you hear audio intermittently at playback, see "Intermittent audio at playback" in section 6.4.
Note 3: If error occurs at the start of playback, click the [Start] button again.
Note 4: When you minimize the Live Player V5 window while replaying the recorded
data, the audio data may not be synched with the display screen. In this case, stop the
replay, then click the [Start] button again.
Note 5: If the message "Audio setup failed" appears during playback, click the [OK]
button. Try to replay data again.

3.1

Reading the Data Recorded in the Long Term
Device
This section explains how to access and play back the data recorded in the Long Term
Device without retrieving the data from the HDD of the replay PC.
Normally, it takes more than one hour to retrieve the recorded data from the Long
Term Device to the replay PC. Using this Live Player V5 software, however, the data
recorded in the Long Term Device can be read to replay it without copying the data
into the HDD of the replay PC. This feature is useful during the installation of the VDR
to check if all the data input to the VDR is properly recorded in the Long Term Device.
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3.1.1

How to connect the replay PC to the Long Term Device
Data can be read from the DATA port J502 in the DCU during recording. If an incident
occurs, you can read the data as follows.
1. Open the door on the cover of the DCU. Connect the LAN cable between the LAN
port on the replay PC and the DATA port J502 in the DCU.

DCU

Data port
J502
LAN
cable

PC

LAN port

2. Start the Live Player V5.
3. Open the [Tool] menu and select [Source Select] to show the [Source Select] dialog box. Select [Long Term Device (LAN)] from the drop-down list.

Select [Long Term
Device (LAN)].

4. Check that the IP address is 172.31.16.200.
5. Click the [Analyze Track] button to show track information.
6. Click the [Connect] button.
After connecting to the Long Term Device, the [Source Select] dialog box disappears.
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7. Click the [Start] button.

Start button

You can change the playback advance speed and select the track number. To
pause the playback, click the [Pause] button.

Setting for playback
advance speed
(x1.0, X2.0, X4.0, X8.0)

Pause button
Stop button

8. To stop playback, click the Stop button.
Note: You can show the [Control] dialog box by putting the cursor in the [CONTROL]
area and dragging the cursor while holding down the left button. This dialog box has
a slider bar for selecting playback start time. You can also specify the playback start
time by entering desired numeric value and clicking the [Set] button.
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3.2

How to Extract Data from a Long Term Device,
Replay the Data on a PC
The data recorded in a Long Term Device can be copied to the HDD of the replay PC
and replayed with the Live Player V5 software. The data copied can also be replayed
by another replay PC. The wiring necessary to retrieve the data is the same as shown
in section 3.1.1.

3.2.1

How to extract the data from a Long Term Device
1. Select [Source Select] from the [Tool] menu to show the [Source Select] dialog
box.
2. Click the drop-down list and select [Long Term Device (LAN)].
3. Click the [Connect] button.
4. Click [Extract] in the [Tool] menu.
5. Select the tracks you want to retrieve, referring to the Start Extraction time, Duration, and End Extraction time. Also, the Start Extraction time, Duration, and End
Extraction time can be changed.
6. Click the [Select] button to show the [Open] dialog box.
7. Select where to save the data and click the [Open] button.
8. Click the [Start] button in the [Extraction] dialog box. The [Extract Process] dialog
box appears and the bar graph, which indicates retrieving status, appears. When
the extraction is completed, the message "Extracting data to … completed" appears.
9. Click the [OK] button and then click the [Close] button.

Notes on extraction
• If "Get size failed" appears at the start of extraction, click the [OK] button to start.
• The message that announces completion of extraction may not appear. If the
progress bar shows 100%, extraction is completed.
• If an error message appears during extraction and extraction stops, restart the Live
Player and try the extraction again.
• The Live Player may stop when extraction is cancelled. If this occurs, quit the
Live Player from the Task Manager then restart the Live Player.
• If the Extraction Process window appears without clicking the START button, close
the window to start extracting data.
• Do not extract data to a medium whose remaining space is too low to hold the data.
The OS may not start up if the medium is the system drive and it is full. (Figure 1GB
for one hour of data.)
• Do not connect a storage device to more than one Live Player in extraction or play
back. Extraction or play back may stop.
• Recording continues when extracting data from a Long Term Device (LAN). Newer
data may not be extracted since older data is written over. If this occurs, set the start
time for extraction backward by some hours.
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3.2.2

How to replay the data copied into the PC
1. Select [Source Select] from the [Tool] menu to show the [Source Select] dialog
box.
2. Click the drop-down list and select [Extract].
3. Click the [Select] button to show the [Open] dialog box.
4. Select the file you want to replay and click the [Open] button.
5. Click the [Analyze Track] button in the [Source Select] dialog box then click the
[Connect] button.
6. Click the [Start] button to show the data on the screen.
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4.

LIVE PLAY
In addition to its replay functions, this software has a “Live Play” capability when the
Live Player PC is connected to the VDR with a LAN cable. The Live Player V5 allows
monitoring all the data input to the VDR in real time at a remote location. This is useful
for checking the current status of all devices connected to the VDR.

4.1

Wiring
Any PC in the network with the Live Player software can access the VDR. Also, two
PCs can communicate with the VDR since the VDR can distribute the Live Play data.
However, the operation via a router cannot be guaranteed.
To connect more than two PCs, consult with your dealer.

Ethernet
DATA port
J502

Note 1: After powering the DCU, the LED display on the RAP and DCU shows “No
connection” for approx. four minutes. Do not connect the Live Player V5 during this
period, to prevent fatal error.
Note 2: The DCU’s Fail Safe function may execute Process Restart, which could disconnect the Live Player V5 from the DCU. If this occurs, reconnect the Live Player V5.
Note 3: Do not connect any devices other than the VR-7000 and the PC(s) w/Live
Player V5 to this network, to prevent malfunction of the VR-7000 by unwanted packet
transmission.
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4.2

How to Display Data
To start Live Player V5, simply select the source of data and click the [Start] button.
Note: When the driver install program is activated during "Live Play", the audio volume
may get louder regardless of the setting on PC. In this case, reboot the Live Player V5.
1. Start the Live Player V5 software.
2. Open the [Tool] menu and select [Source Select].
3. Click the drop-down list and select [Live].
4. Click the [Connect] button.
5. Click the [Start] button to play back data in real time.

Start button

To pause the live play, click the [Pause] button.

Pause button
Stop button

6. To stop playing back the data, click the [Stop] button.
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DATA DECODER
The decoder library is used to organize the decoders. A decoder is a small script that
describes how information is decoded and retrieved from a specific NMEA sentence.
This means any sentence can be decoded and displayed in a user-specified form with
this software if the sentence fully meets the NMEA standard (proprietary sentence is
also accepted).
The decoder descriptions use VDR specialty script language. The descriptions are
checked, and if error is found, the message “Syntax error” appears. When this occurs,
data cannot be loaded or saved.

5.1

Opening the Decoder Library
1. Click [Configuration] menu > set [Configuration Mode] to [ON] > click [Decoder Library] in the [Configuration] menu.
2. Click [Configuration] menu and [Decoder Library] to show the [Decoder Library]
dialog box. See section 5.2.
3. Click the applicable “+” button in the left window to show the data sentences for
that group. Click an item to show its information in the [Decoder Information] window. This library supports all the sentences specified in IEC 61996.
4. To edit a sentence, click the [Edit] button.
A confirmation message appears. Click the [OK] button in the message to show
the [NMEA Decoder Editor]. See section 5.3.
Sentences not supported by this library can be input to the VR-7000 to create a decoder for the sentence. In addition, you can program the decoder so that a specified
data can be picked up and displayed on the [Replay] and [Live Play] window.
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5.2

Decoder Library

Decoder library
Red "X": write-protected
Decoder group

[Decoder Group]: A decoder belongs to a group, and all decoders in the same group
are stored in the same folder. Groups have been defined corresponding to the data
items to be recorded. The user may establish new groups.
[Sentence formatter]: A decoder is only able to retrieve information from one specific
NMEA sentence. A typical decoder is only able to retrieve information from one field
in an NMEA sentence. Most NMEA sentences contain many fields, hence a number
of decoders may be needed for retrieving all the information from one sentence.

Sentence formatter
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[Decoder name]: A decoder must be assigned a name, and the name must be unique
within the decoder group.

Red X: Write protected

[Write-protected decoders]: A number of standard decoders (protected decoders)
have been defined. These decoders are write-protected and cannot be changed or deleted by the user. These are indicated with a red “X” mark as shown above. However,
the operator may use one of these decoders as a template for a new decoder.
[Sub-library]: The Player, at startup, “compiles” the library from a number of library
files each containing a number of decoders. The standard decoders are stored in one
file and another file is used to store the user-defined decoders. The user is not able to
add or delete the sub-library files.
[Decoder output]: The output from a decoder may behave like analog data, digital
data or a text string. This information may be indicated for a decoder. However, this
information is only informative and will not be used by the Player.
[Input type]: The input type of the standard decoders defined are all NMEA. A unique
input type can be defined for a decoder.

Drop down menus
[File] -> [Import]: Import decoders from an external file. The imported decoders will be
added to the user defined sub-library file.
[File] -> [Export]: Four choices to export decoders:
[All Decoders]: Export all decoders
[Selected Decoder/Folder]: Output decoders contained in a folder.
[All Decoders (incl. Library decoders)]: Export all decoders incl. library decoders.
[Selected Decoders (incl. Library decoders)]: Export all decoders contained in a folder,
incl. library decoders.
Note: When the decoder detects an error, data cannot be imported or exported and
the message "syntax error" appears.
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Decoder library
• The decoder library is shown to the left. The “radio buttons” at the top define how
the library is organized.
• A context-sensitive menu, which has the functions listed below, is available by right
clicking on a folder or a decoder.
[New Folder]: Add a new folder in the library.
[New Decoder]: Add a new decoder in the library.
[Copy]: Copy the selected decoder.
[Edit]: Open the decoder edit screen.
[Rename]: Change the name of selected decoder or folder.
[Delete]: Delete the selected decoder or folder.
• A new “root folder” can be created by right clicking on the empty space beneath the
“library tree”.

Decoder description
The remaining decoder properties, for the selected decoder, are shown in decoder description located to the right of the decoder library window.

5.3

Decoder Editor
You can edit a decoder that has been defined, in the [Decoder Editor] screen. The [Decoder Editor] may be opened from the decoder library (see next page). Select a decoder from the [Decoder Library] dialog box and click the [Edit] button.
Note: Do not create a blank decoder. Viewer settings cannot be downloaded if they
were uploaded with a blank decoder.
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General buttons
[OK]: Save changes after the editor window is closed. The previous version of the decoder is overwritten.
[Cancel]: Close the editor window; any changes made will be ignored and lost.
[Save As]: Close the editor window. Changes made may be saved if the [Save As]
button in the decoder library is activated. This will give the operator an opportunity to
save the changes using a new name/folder while maintaining the previous version of
the decoder.
To make a new decoder, do as follows:
1. Click [Configuration] menu > [Configuration Mode] > ON.
2. Click [Configuration] menu and [Decoder Library] to show the [Decoder Library]
dialog box.
3. Select the [Decoder Group] radio button in the [Sort By] window.

4. Right click on the empty space beneath the library tree in the [Decoder Library] to
show the [New Folder] button.
5. Right click the [New Folder] button and click [Rename] to enter a name for the folder (For example: Contact Signal).
6. Right click the new folder (for example, Contact Signal was named at step 5) and
click [New Decoder] in the menu displayed.
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7. Right click [New Decoder] and click [Rename] to enter a name for the new decoder (for example: No.1 Door).

New folder
New decoder name

8. Double click the new icon (in the example in step 7 it is No. 1 Door) to show the
Decoder Editor dialog box.
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9. Select and enter items as follows.

Enter descriptive
name for decoder.

1
2
3
4
5
6
7
8
9

Search for "PWATD01"
if #3="CLOS"
print "CLOSED"
stop
endif
if #3="OPEN"
print "OPEN"
stop
end if
Enter

Begin

script for defining
decoder. Use VDR
dedicated-script language*.

Enter test sentence in
NMEA format

$PWTD01,,OPEN,A*hh

*: Contact Furuno service center for details.
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10. Click the [TEST] button. The decoder may be tested against an NMEA sentence.
The test results are displayed in the [Result] box and the [Trend Value] box. The
decoded data is checked, and if error is found the message "syntax error" appears. The decoder cannot import or export data when error is found.

1
2
3
4
5
6
7
8
9

Search for "PWATD01"
if #3="CLOS"
print "CLOSED"
stop
endif
if #3="OPEN"
print "OPEN"
stop
end if

The third data in the test sentence
is "OPEN" and then "OPEN" is
displayed as result.

11. Enter [Decoder] name and click the [Save As] button to save the decoder and
erase the [Decoder Library] dialog box.
12. Click the [Close] button.
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OTHER SETTINGS

6.1

Alert Popup
The [Alert Popup] dialog box provides the following operations:
• displays alert information (time and status of alerts)
• acknowledges alerts, stops buzzer
• configures objects for alerts
To show the [Alert Popup] dialog box, set the Configuration Mode to OFF, click [Tool]
and [Alert Display] on the menu to activate the [Alert Popup] dialog box.
Note: With [Source Select], choose [Live], [Fixed DRU], [Float DRU], [Long Term Device(Direct)], [Long Term Device(LAN)], or [Extract] beforehand.
Alert Popup

[Buzzer Stop] button: Mute the audio until a new alert is generated.
[ACK] button: Acknowledge alerts (one by one) shown.
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Configuration of objects for alerts
The [Alert Definition List] stores up to 50 objects for alerts. When the storage capacity
is exceeded, an error message appears. If this occurs, do not click the Close button
to close the window. Configuration cannot be completed correctly.
1. In the [Configuration Mode ON] state, click [Alert Definition] in the [Configuration]
menu to show the [Alert Definition List].
Alert Definition List

2. Click the [Add] button to show the [Alert Definition] dialog box.
Alert Definition

3. Enter a name for the alert in [Alert Name] box. A maximum of 32 characters may
be used. Do not exceed 32 characters, because all alerts cannot be displayed if
an alert name is too long.
4. Click the [Set…] button to right of the [Occurrence Condition] box.
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5. Open the [Analog], [Digital] or [Serial] tab and enter the condition that triggers the
alert for each format.
[Analog] tab
Alert Condition Definition

Set a signal input channel among AN001 to AN120. Set a formula for the alert conditions.
Value

Symbol

Input ch.

Symbol

Value

A

blank

AN001

blank

B

<
<= (≤)
== (=)
!= (=)

<
<= (≤)

Example: If a signal of input ch. AN001 is greater than 12 and
less than 24, then 12 < AN001 < 24

[Digital] tab
Alert Condition Definition

Set a signal input channel among DC001 to DC640 and select 1 or 0.
Example: If a signal level is normal low (0) and the signal goes to high level (1)
for alert state, select 1.
[Serial] tab
Alert Condition Definition
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Set a signal input channel among SI01 to SI72. (SI17 and higher are no use.) Select a signal sentence in the Library. Select a setting method between [Number]
and [Letter]. For [Number], set a formula for the alert condition.
Value

Symbol

Input ch.

Symbol

Value

A

blank

SI001

blank

B

<
<= (≤)
== (=)
!= (=)

<
<= (≤)

Example: If a signal of input ch. SI001 is greater than 12 and
less than 24, then 12 < SI001 < 24

[Sensor (LAN)] tab
Alert Condition Definition

Set a signal input channel among LN01 to LN64. Select a signal sentence in the
Library. Select a setting method between [Number] and [Letter]. For [Number], set
a formula for the alert condition.
Value

Symbol

Input ch.

Symbol

Value

A

blank

LN001

blank

B

<
<= (≤)
== (=)
!= (=)

<
<= (≤)

Example: If a signal of input ch. LN001 is greater than 12 and
less than 24, then 12 < LN001 < 24

6. Click the [OK] button several times to close the [Alert Definition List].
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6.2

Settings for Alert

6.2.1

Buzzer setting
Set how to handle the buzzer that sounds for alerts.
1. Select [Buzzer Setting] from the [Tool] menu.
2. Select a radio button.
• [Once]: The buzzer sounds once.
• [Loop]: The buzzer sounds continuously. To stop the
buzzer, click the [Buzzer Stop] button in the [Alert Popup] screen.
• [Disable]: Mutes the buzzer.
3.

6.2.2

Click the [OK] button.

Alert popup screen
Activate or don’t activate the [Alert Popup] screen when an alert occurs.
1. Select [Alert Popup] from the [Tool] menu.
2. Select [ON] or [OFF] as appropriate.
• [ON]: Activate the [Alert Popup] screen when an alert occurs.
• [OFF]: Don’t activate the [Alert Popup] screen when an alert occurs.
Alert Popup

[Buzzer Stop] button: Click to stop the buzzer.
[ACK] button: Acknowledge alerts (one by one) shown.
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6.3

Extraction of Recorded Data
The analyze function can extract a necessary data from recorded data and save it to
the HDD in the PC.

Notes on extraction
• Free space of more than 30 GB is required in the C drive of the PC to create a temporary file for the analysis.
• The data recording more than 13 hours cannot be extracted and analyzed at once.
• When you click the [Extract Furuno Format] or [Extract IEC Format] button consecutively, two [Extract Process] windows are shown and you cannot close the Live
Player V5. In this case, activate the task manager of Windows® to shut down the
task.
• Do not select the source to other than [Extract] or [Long Term Device](LAN) for recording.
• If "Get size failed" appears at the start of extraction, click the [OK] button to start.
• The forecasted value of the displayed data size is the overall data size. It is not the
size of the extracted data.
• If extraction does not start properly, restart the Live Player and try again.

How to extract recorded data
1. Set the Configuration Mode to OFF, then select [Source Select] from the [Tool]
menu.
2. Select a data source (except Live) from the drop-down list and connect the line.
3. Click the [Analyze Track] and [Connect] buttons.
4. Click [Analyze] in the [Tool] menu to show the [Extractor Analyze] dialog box.

5. Check the track you want to extract in the [Track Selection] window.
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6. Click the [Select Period] button and set the start time and the end time.

7. Click the [OK] button to confirm the times and return to the [Extractor Analyze] dialog box.
8. Put a checkmark on data type and channel on the [Data Selection] window.
For [Serial], [Sensor(LAN)], [Analog], [Digital], click corresponding button and select required channel. [History] defines what data to extract. [All] extracts all data,
[Alert Only] extracts only alert data and [Off] extracts no data.
9. Define an output format for each data in the [File Format] window.
10. Click the [Select] button and specify saving location in the [Folder/File Name] field.
11. Click the [Extract Furuno Format] button.
12. After completing the extraction ([Progress of All] becomes 100%), click the [Close]
button.
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6.4

Audio Setting
The audio can be set from the menu bar. Click the [Tool] menu in the menu bar and
then click [Volume] to show the [Audio Volume] dialog box. (If a password was defined
at installation, enter the password.) Set each item as shown in the figure below.

Click each loudspeaker
icon to turn on or off.
Adjust volume of audio.

Check to mute audio.

Intermittent audio at playback
Depending on the PC, you may hear audio intermittently. In this case, set the audio.ini
file as follows.
1. Close the Live Player V5.
2. Open the audio.ini file in C:\Program Files*\VDRViewer\Viewer\config folder by
the Notepad. *“Program Files(x86)” for 64 bit Windows®8.
3. Change LocSoftWare = 0 to LocSoftWare = 1.
4. Change RestoreDirectSound = 0 to RestoreDirectSound = 1.
5. Save and overwrite the audio.ini file.
6. Start the Live Player V5.

No audio at playback
If there is no audio from a Windows XP® PC during playback, do as follows to get audio.
1. Click the [Start] button, [Control Panel], [Sound and Audio Devices].
2. Click the [Audio] tab, then click the [Advanced] button.
3. Click the [Performance] tab.
4. Move the [Hardware acceleration] slider all the way left.
5. Click the OK button twice.
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6.5

How to Set Password for Audio Reproduction
Do the following procedures to set password for audio reproduction. The default has
no password.
1. Select [Password] from the [Tool] menu to show the [Password Setting] dialog
box.

2. Enter old password in the [Old Password] box. (In the default setting, no password
is set.)
3. Enter new password in the [New Password] box.
4. Enter the new password in the [Confirm New Password] box.
5. Click the [OK] button.

How to set audio reproduction
You can set the audio reproduction on or off.
1. Select [Audio] from the [Tool] menu.
2. Select [ON] or [OFF] as appropriate.
If you select [ON], the password screen appears.
3. Enter password and click the [OK] button.
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7.

LIVE PLAYER V5 BACKUP
The Live Player V5 can use the internal hard disk in a PC for backup, however it is
strongly recommended that a drive bay with a removable hard disk is used for this purpose.
Removable hard disk

USB cable

Laptop PC

Desktop PC

To start backing up data, select [Backup] in the [Tool] menu to show the [Backup] dialog box.









Note 1: Do not start the backup program when displaying in real time. This will overload the processor, causing the backup or live-play to malfunction.
Note 2: Duration of Backup
A typical VDR system will generate 24GB of data each day (in case of radar 3ch). Do
not specify drive route. If necessary make a new folder.
Note 3: Use a Long Term Device formatted to NTFS. Do not use a Long Term Device
formatted to FAT32. Data may be damaged if the volume of the Backup Region is set
for 2GB or more.
Note 4: If you force-quit the Live Player V5 during the backup process, restart the Live
Player V5 and perform the backup process again.
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7.1

Starting the Backup Process
A disc must be selected for back up before the backup process can start.
1. Open the [Tool] menu then select [Backup] to show the [Backup dialog] box.
2. Click the [Modify] button in the [Backup] dialog box to show the [Backup Config]
dialog box.

3. Click the [Select] button and specify a folder to be saved. A new folder is created
and named by date and time in the specified folder.
Note 1: All data in the specified folder for backup are erased. Be sure to specify
a new folder for backup.
Note 2: Do not save data to root of drive. Make a new folder and save data there.
4. Set a volume for backup data in the [Backup Region] box (more than 500 MB).
5. Set the IP address of the VR-7000 in the [IP Address] box.
6. Check [Stop Recording] in the [End of Disc Action] window to stop when the disc
is full.
Check [Ignore Warning and Continue] to continue even if the disc is full - the oldest
data will be overwritten.
7. Click the [OK] button to close the [Backup Config] dialog box.
8. Click the [Record] button in the [Backup] dialog box to start backing up data. The
bar graph in the [Backup] dialog box shows progress.
9. Click the [Close] button to close the dialog box.
10. To stop backing up data, click the [Stop] button.
Note: After you stop or finish backing up data, disconnect the external HDD or reboot
the PC. For Windows®8, the shutdown function does not stop the backup function.

7.2

Settings After Restart of Program
Setting data is backed up to the disc upon exit from the program. Backup will be done
in subsequent exits provided the disc used for the previous backup is still available.
Note: The Live Player continues to store data automatically after recovery of lines,
close of Backup dialog box or restart of the VDR.
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7.3

Replaying the Extracted Data
1. Start the Live Player V5 software.
2. Click the [Tool] menu and [Source Select] to show the [Source Select] dialog box.
3. Select [Extract] from the drop-down list.

4. Click the [Select] button and select a folder you want to replay.
5. To see track information in the extracted data, click the [Analyze Track] button.
The track information appears in the lower part of the dialog box.
6. Click the [Connect] button in the dialog box.
7. Click the [Start] button to replay the extracted data. The replaying will start.
8. To stop replaying, click the [Stop] button.
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8.

SERIAL OUTPUT FOR OTHER
APPLICATIONS
The Live Player V5 can output serial data to other applications.

Configuration of serial output
1. In the Configuration Mode [OFF], click the [Tool] menu and [Serial Output] to show
the [Serial Output] dialog box.

2. Click the [Add] button to show the [Serial Output Config] dialog box.
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3. Select a serial output port of the VR-7000 from the [Inactive] window and move it
to the [Active] window.
Note: Up to four serial output ports can be selected in numerical order. More than
five output ports cannot be selected.
4. Select output port from the [Output] drop-down list.
5. Click the [Detail Setting] button to show the [Serial Output Detail Config] dialog
box.

6. To use the default settings, check the [Use Default Setting] box. If you do not use
the default, set each item in the dialog box.
7. Click the [OK] button. The [Serial Output Detail Config] dialog box disappears.
8. Click the [OK] button.
9. Enter check mark in the row of [Active] and set items for data output.
The operator may select a number of data sources and one output port.
To modify the serial output, select the item you want to modify and click the [Modify]
button.

Merging of data
The program is designed to handle NMEA sentences, i.e., two sentences will not be
interleaved but sent one at a time. The program may fail to relay ASCII or binary data
depending on the properties of the data.
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AIS DISPLAY

9.1

Display Layout
Click the [AIS Viewer] tab to show the AIS display. Click [Source Select] in the [Tool]
menu. Set media, then click the [Start] button to show AIS data.
Note: The presentation mode is fixed to North-up (true bearing). See below for description of display items.

(1) AIS graphic window
Displays AIS transponder equipped vessels with symbols.
• The concentric circles are range rings. You can change range by clicking the [Zoom
In] or [Zoom Out] button. You can display this window in full screen by double clicking the AIS window.
• The radial line extending from screen center is own ship’s heading.
• AIS targets are marked with a triangle. Symbol appearance changes with target status. The display can show a maximum of 500 targets (nearest targets from own
ship) simultaneously.

(2) Own ship information
Latitude, Longitude, SOG (speed over ground), COG (course over ground) of own
vessel is shown. You can display detailed information by clicking the [Details] button.
See section 9.4.
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(3) Target data box
A target is selected by left-clicking it on the graphic area. Click it again to deselect. The
data of three targets may be shown simultaneously. See section 9.5. To clear data,
click the [Close] button. Other ships’ data includes Name, Call sign, SOG, COG, TCPA
and CPA. To display detailed data, click the [Details] button.

(4) Cursor data
Bearing and range from own ship to cursor position.

(5) Settings button
Click the [Settings] button to display the following dialog box and set necessary items.

[CPA threshold]: Set further distance for which to classify a target as a dangerous
target.
[TCPA threshold]: Set maximum time for closest point of approach for which to classify a target as a dangerous target.
[ROT threshold]: Display condition of ROT direction. Set highest ROT value for which
to display ROT line on target.
[Selected Channel]: Set serial port of the VR-7000 that AIS data inputs.
[Scale of Distance]: Turn range ring distance indication on or off.

(6) All Sentence button
Click the [All Sentence] button to show all AIS sentences.

(7) Target list
Lists all targets, in range order from own ship.
[Label]: The label A, B or C is attached to targets selected to show their data in the
Target Data Box.
[MMSI]: MMSI number of target
[Name]: Ship’s name of target
[Call sign]: Call sign of target
[Range]: Distance from own ship to target
[Bearing]: Bearing from own ship to target
[Target]: Status of target (dangerous or lost) is also indicated.
To display detailed data about a target, select it from the list and click the details button.
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9.2

Target Symbols

AIS target
Sleeping target

Symbol

Activated target

Dangerous target

Description of symbol
An isosceles, acute-angled triangle with its centroid representing the target’s reference position. The most acute
apex of the triangle is aligned with the heading of the target, or with its COG, if heading information is not available.
Same as above but line is thicker.

A target becomes a dangerous target when its CPA and
TCPA are smaller than a set value. The symbol is displayed in red.
If the TCPA becomes negative, the dangerous target becomes a normal target.
A thin green line is put at the apex of the target to indicate
the vessel’s heading.

Heading line

Heading line, ROT

Direction of turn indication (if available) to display actually
initiated course.

Speed vector

The speed vector is displayed as a dashed line starting at
the centroid of the triangle.

A to N

Aid to navigation

Selected target

A selected target is marked with a broken square.

Lost target

A target changes into a lost target when its data is not received for three minutes. Further, the lost target disappears when no data is received for an additional three
minutes.

Lost A to N

Lost AIS target
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9.3

Display Range
Display range may be chosen by clicking the [Zoom In] or [Zoom Out] button. The table below shows the available ranges.

Range (nm)
Range ring
interval (nm)
Number of
Range rings

9.4

0.125 0.25

0.5

0.75

1

1.5

0.025 0.05

0.1

0.125

0.2

0.25

5

6

5

6

5

5

2

3

4 6 8

12

16

24

48

96

0.4 0.5 1 1 2

2

4

4

8

16

6

4

6

6

6

6

4 6 4

Own Ship Details Window (detailed information)
Click the [Detail] button in the own ship information area to show the own ship details
data. The window shows the data for Message ID 1. “---” is shown where there is no
data.

Message ID 1 window
There are 27 message IDs as shown in the figure above. To show the details for another message ID number, click the desired message ID number.
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9.5

AIS Target Details Window
Press the [Detail] button in the target data box to show the AIS target details data. The
window shows the data for Message ID 1.

Message ID 1 window
There are 27 message IDs as shown in the figure above. To show the details for another message ID number, click the desired message ID number.
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9.6

Message Logs

9.6.1

RX message log
Press the [RX LOG] button in the target list area to show the RX message log (VDM
sentence).

[RX log] window
[MMSI (source)]: MMSI number of a message sending station.
[Time/Date]: Time and date which the VDR recorded the message.
[ID]: Message ID (ID6 or ID12: addressed message, ID8 or ID14 broadcast message)
[Message]: The first 32 characters of an RX message are displayed.
To show the full message (in the [Message] window), select the message from the list.
To close the RX message log, click the [Close] button.
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9.6.2

TX message log
Press the [TX LOG] button in the target list area to show the TX message log (VDO
sentence).

TX log window
[MMSI (Destination)]: MMSI number of a message receiving station. [Broadcast]
means broadcast message.
[Time/Date]: Time and date which the VDR recorded the message.
[ID]: Message ID (ID6 or ID12: addressed message, ID8 or ID14: broadcast message)
[Message]: The first 32 characters of a TX message are displayed.
To show the full message (in the [Message] window), select the message from the list.
To close the TX message log, click the [Close] button.
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10. VDR CONFIGURATION
10.1

How to Confirm the VDR Configuration
After connecting the PC to the VDR in the Live Player V5, you can check the VDR configuration. The display shows the VDR setting data of the latest connected sources.
1. Select [Source Select] from the [Tool] menu.
2. Select [Live] from the [Source Select] dialog box.
3. Click the [Connect] button.
4. Click [Configuration] > [VDR Config].
5. Click each tab to confirm the VDR settings.
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10.2

Configuration File in the PC
You can confirm the configuration file that you have stored in the PC as follows.
1. Disconnect the Live Player V5 from the VDR.
2. Click [File] menu on the Menu bar.
3. Select [Open VDR Config] to show the [VDR Config File Selection] dialog box.
4. Select the configuration file and click the [Open] button.
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APPENDIX 1 MENU TREE
Menu bar
File

Open VDR Config
Exit

Tool

Source Select
Volume
Extract
Analyze
Alarm Display
Buzzer Setting
Alarm Popup
Audio
Password
Serial Output
Backup

Live, Fixed DRU, Float DRU, Long Term Device (LAN),
Long Term Device (Direct), Extract

Once, Loop, Disable
ON, OFF
ON, OFF

Configuration

Configuration Mode
ON, OFF
Sheet
Decoder Library
Alarm Definition
Viewer Config Management
VDR Config

Help

About
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APPENDIX 2 MATERIALS FOR
PLAYBACK
IMO Circular MSC.214(81) recommends that all VDR systems installed on or after 1 June 2008
carry the software to playback data on a PC, the manual for data extraction, and the cables necessary to connect the PC to the Data Collecting Unit (DCU).
For convenience, a pouch is provided to store those items in the DCU.
Item

Type

Code No.

Live Player V5 Software CD

2450104/05-

001-279-090-00

Data Extraction Procedure

E42-01402

000-179-354-10

LAN Cable

MOD-Z072-020+

001-167-880-10

Remarks
w/accessories
FP24-01110

See the data extraction procedure for how to play back data.

How to attach the pouch
Use the supplied accessories to attach the pouch to the DCU. Remove the paper from the doublesided tape on the pouch. Attach the pouch to the location in the DCU shown below, aligning the
bottom edge of the pouch with the bottom edge of the door.

㪛 㪸㫋㪸㩷㪜㫏㫋㫉㪸㪺㫋㫀㫆㫅㫄㩷㪧㫉㫆㪺㪼㪻㫌㫉㪼

Pouch
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